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           Anzio connection timing out

        
          

        

        
          
          
            There are many things that control a connection for Anzio Lite and AnzioWin. This includes network devices, the host application, the host operating system, user login scripts, Microsoft Windows settings and more.


Telnet and Secure Shell (SSH) connections are stateful connections and must be up and available whenever a character of any type is passed either direction. If not, the user's connection can be dropped and thus, depending on the settings in Anzio, the Anzio window may close. This type of failure usually indicates some network or server action timed out, or the network connection was not available.


This is different than how the FTP (file transfer) or HTTP (web browser) protocol behaves, these protocols simply try to reconnect since no login is necessary.


These type of dropped connections are most often seen when connecting over the Internet through an ISP (Internet Service Provider). They can also occur when a hub, router or network switch is not properly configured or when one of these devices is beginning to fail (generating errors). There are some options a user can do to try to get around the issues:


	Contact your ISP and let them know you are doing telnet or secure shell connections and the connections are dropping (if you get the right tech person, he/she will know what is miss-set in your connection to them).
	Check your devices in-house and see if one of them is getting errors in their log file. If they are unmanaged devices, switch ports and see if the problem moves.
	Make sure the host system is not timing out. There should not be a "tmout" or "tout" inside your host script files (.profile or login scripts). Also make sure the host and PC network cards are not generating any network errors.
	Try setting the "Stay Alive" parameter (available in version 15 or later). Check under the Communications menu and Network : Stay Alive. This option, when set greater than zero, will send a single empty packet over the network stating that Anzio is still alive and working (typically set this for 30 seconds). However, setting this option too low may only show the problem earlier and more often and not really hide it. Again this option is masking some other problem or misconfiguration, but it will help in about 80% of the cases.



Check out the following pages for more information:


	A Guide to Telnet 
	Troubleshooting a Telnet Connection 
	Connections Timing Out




      
          

      

  







    

  
      
          
        
           Anzio flashes up and then shuts down

        
          

        

        
          
          
            Several items can cause this behavior. If Anzio should try to connect, then flash off, or you get a "runtime" error, or you get passed the login, but Anzio disappears, there are several possibilities:


	The host has a user limit in effect
	The host name or address is wrong
	The port you are trying to connect to at the host is incorrect
	The default file is corrupt
	You have selected the wrong terminal type for your host login or your host application
	A router with port forwarding is limited to a single user and already in use
	The login you used is limited to one connection and is already logged in



For any of these, check to make sure you have set up Anzio correctly for your host connection (correct port, correct host name or IP address, correct terminal type and correct login). If all else fails, you can try clearing out the default file for Anzio and reset the startup settings:


1) Look under the Windows Start menu and All Programs for the Anzio folder. Inside this folder you should see the item "AnzioWin (new connection)" or "Anzio Lite (new connection)". Run the appropriate menu item to start Anzio without a default file.


2) If Anzio was working but is not now, try renaming or deleting the file "anziowin.def" located in the same directory as the executable. By doing this you will have to re-enter all your initial values, but it should clear up the bad record.


3) You can also accomplish the same thing as above by starting AnzioWin or Anzio Lite from the Start:Run dialog by entering:



	c:\anzio126\anzio32.exe none

	        or

	c:\anzio126\anzio32r.exe none


The word "none" will start Anzio without a default file. You can then save the new settings over the top of the old when you exit, thereby replacing the bad default file.



      
          

      

  







    

  
      
          
        
           Anzio returns a printer error (5001, 5002, ...)

        
          

        

        
          
          
            When passthrough printing or screen printing through Anzio returns a printer error in the 5000 range, this usually indicates that some data was passed through from the host and Anzio tried to print it directly to the spooler or to the raw device, bypassing the printer driver.


	If your passthrough print job contains escape sequences for a specific printer, such as PCL for HP printers, and you try printing this on a different printer, such as an Epson, you may get printer errors. Make sure if your passthrough print job contains printer language it is printed on the right printer.
	If you receive these errors on a passthrough print job that does not contain any escape or control sequences that are printer specific, then check your "print level" in Anzio. Typically a printer error of 5002 in these cases would indicate that Anzio is set for "spooler" or "raw" print level and the printer does not support this type of printing. Change the print level back to "high" or "Print Wizard" (if AnzioWin).
	If you are sending escape sequences and the printer driver appears to be right, check which language is supported by the printer driver and that it is the same language as the host application is sending. PCL-6 will not print on a PCL-5 driver, and PCL in general will not print through a Postscript driver (check to see if the printer installed different drivers for different printer languages).



If all else fails, either give your application vendor a call, or call our office and ask for tech support.



      
          

      

  







    

  
      
          
        
           AnzioWin is returning a winsock error code or 10022 when I try to run it.  What does this refer to?

        
          

        

        
          
          
            	Winsock error code 10022, it is kind of a catch-all for unknown problems. If this is a new machine or you have recently installed or updated any internet security software, the problem is most likely related to the personal firewall they turn on. Windows Firewall is not usually the problem because by default it does not block outbound traffic, just inbound traffic, whereas others block both. While you may be able to "ping" the host, do normal web access and even use Windows "telnet", the security suite's firewall software may be preventing access for any other program. In order to test this, disable the firewall in these programs and restart your PC. If that works OK, then check to see that these software packages have your telnet or ssh port "unblocked", or add the appropriate Anzio program to their "exceptions" list ("anzio32r.exe" for Anzio Lite and "anzio32.exe" for AnzioWin, found in the default Anzio directory, usually C:\Program Files\Anzio15\). Note: It is often necessary to restart the PC after any firewall changes for those changes to take affect. Also, it may be necessary to start a new Anzio session in order for Anzio to now connect. Go under the Windows Start:Programs:Anzio folder and select "Anzio (new connection)" and establish a new network connection. Once connected, save these new default settings through the File menu over the top of the old. This error is most often seen with ZoneAlarm, Black ICE, Norton Internet Security or McAfee Internet Security Suite.



      
          

      

  







    

  
      
          
        
           Are AnzioWin and Anzio Lite compatible with terminal servers?

        
          

        

        
          
          
            Yes, we have AnzioWin and Anzio Lite running on many terminal servers around the marketplace. The only catch, similar to running from a file server (see above), is manually setting up shortcuts and making sure default files are referenced and read-only as necessary. As for entering a serial number/activation code for each workstation, this may not be necessary. We do have a method of accessing a global license entry - call for more information. Note that AnzioWin and Anzio Lite are licensed on a per-workstation base, a single license for each node accessing it from a terminal server, not one license per server, but one license per workstation.



      
          

      

  







    

  
      
          
        
           Can AnzioWin and Anzio Lite run from a file server?

        
          

        

        
          
          
            Yes it can. In brief, you install Anzio on the file server and then set up shortcuts on the individual PCs which are sharing the file server's disk, to point at the Anzio software.


You can set up individual default files (if you do, reference them on the shortcut command line, e.g., "N:\Program Files (x86)\Anzio17\anzio32.exe" my.def) or let Anzio use its common default file name ("anziowin.def" for both AnzioWin and Anzio Lite), by just referencing the executable.


Or you can have all the instances of Anzio share a common settings file on a network drive (e.g., "N:\Program Files (x86)\Anzio17\anzio32.exe" N:\settings\standard.def). In this last case, you may want to make standard.def a read-only file to prevent one user from changing settings.


More details on Anzio's command line parameters are in the Anzio manual, section 10.2.


Note that AnzioWin and Anzio Lite are licensed on a per-workstation basis.



      
          

      

  







    

  
      
          
        
           Can I automate a file transfer?

        
          

        

        
          
          
            	In short, YES. There are two procedures that are commonly used and I am sure others exist. With AnzioWin, commands can be issued from the host system controlling Anzio's functionality, either telling Anzio to run a PC program or have Anzio perform an internal function. The two most common procedures to follow involve ZModem or FTP. There are several helpful documents in our knowledgebase dealing with the various types of file transfers available through Anzio.



      
          

      

  







    

  
      
          
        
           Can I change Anzio's screen fonts, screen size, and colors?

        
          

        

        
          
          
            Yes, under the View menu in AnzioWin and Anzio Lite, you can set the particular screen size and font according to your own preferences. Also note that you can zoom (maximize) the window, in which case Anzio uses the full screen and auto-adjusts the font size to fit to the screen resolution. If the window is NOT zoomed, you can set the font size, and the window size will follow. You can also walk through screen font changes quickly by doing an Alt-L (for "larger", to step up one size), Alt-S ("smaller", step down one size) and Alt-Z (to zoom to full screen).


Your choice of font (in View:Screen font) is critical. You will almost certainly want to choose a fixed-space font, such as Courier New, Lucida Console, or Terminal. We recommend Courier New.


You can also choose your Screen Size, which is the number of rows and columns of characters to be displayed. Note that this may have to be coordinated with the host system. And the host system may periodically send out control sequences to switch from 80-column to 132-column modes, for instance.


Anzio keeps track separately, for 80-column and 132-column modes, of your preferred settings for zoom and character size.


Colors can be manipulated through the View:Colors setting. With this option you can select how each possible attribute from the host appears on the screen, i.e. reverse, blink, underline, etc. Color codes can be translated into a color combination by selecting the code to change, followed by the color from the color table. Whenever the host sends this attribute again, the colors will change (you must repaint the screen for this to take affect).


Be sure after making any of the above changes, that you do File:Save Settings again.



      
          

      

  







    

  
      
          
        
           Can I print a file that already has printer-specific codes with Print Wizard?

        
          

        

        
          
          
            There are two options here.


If the print file has printer-specific escape sequences in the file, Print Wizard will pass this directly to the printer without trying to format or auto-fit any portion of the print job. So you need do nothing in this case.


If the print file contains control sequences and tag printing that Print Wizard does not see as printer-specific codes, you can still print direct to the printer by including the command-line switch to print to the spooler or to print raw:



	/vlevel=spooler       or       /vlevel=raw



      
          

      

  







    

  
      
          
        
           Can I print a PCL file with Print Wizard?

        
          

        

        
          
          
            	Yes, Print Wizard version 3.0 or later supports printing a PCL file directly. The question may be one of what level of PCL is the file in and whether your printer supports PCL. If you are printing to a non-PCL printer, and the PCL codes are for version PCL 5 or earlier, you can turn on "translatepcl" with a command-line switch (or via a "print profile") and Print Wizard will translate this to your specific printer. If you are printing to a PCL printer, and the file contains PCL 5 or earlier, you can either print this direct or with the "translatepcl" command-line switch. If you are printing a PCL 6 or later file, you need to print this to a PCL 6 or later printer driver as it will not work with a PCL 5 or earlier driver, not can Print Wizard handle the translation to a normal printer driver. This means that you cannot print PCL 6 on a non-PCL printer currently.



      
          

      

  







    

  
      
          
        
           Can I run Print Wizard from a script?

        
          

        

        
          
          
            Yes. All of the Print Wizard engine functionality can be run from within a script. With the "/q" command-line switch for quiet-mode, Print Wizard will display no dialogs, but will return error codes. See the Print Wizard manual for a complete list of error codes returned.



      
          

      

  







    

  
      
          
        
           Can I run Print Wizard from my own application?

        
          

        

        
          
          
            	The Print Wizard engine is designed to be fully functional through the use of print profiles and command-line switches.

	
		You can run Print Wizard through a shell execute or Exec command. With the "/q" command-line switch to prevent any dialogs from appearing and will return error codes to the hosting application.
	
		You can run Print Wizard from a file association by specifying a specific extension as being printed with Print Wizard (see the Print Wizard manual on setting it up as a File Association). Then you simply start the file through a shell execute or Exec command.
	
		You can include Print Wizard in a script that runs from your program, returning an error code if the print job should fail.
	
		You can run the Print Wizard DLL, calling the various methods exposed to allow Print Wizard to handle all your printing needs.
	
		You can run the Print Wizard ActiveX module from your program. WePO exposes a subset of the Print Wizard calls, allowing you to use it in your .NET or Windows application.



	At present, Print Wizard does not support COM or DDE directly. We are working on this for the future. If you have any need let us know.


      
          

      

  







    

  
      
          
        
           Can Print Wizard print graphics files?

        
          

        

        
          
          
            	Print Wizard supports several graphics file formats, including the option to print them at true size or at full page, stretching as needed. The possible formats are TIFF, JPG, GIF, WMF or BMP.


      
          

      

  







    

  
      
          
        
           Do we have a version of Anzio for the Mac?

        
          

        

        
          
          
            As with mobile devices, there has not been much request for terminal emulation on Apple Macintosh operating system. Currently Anzio Lite and AnzioWin are Windows-only applications. However, we have had a fair number of users running Anzio Lite and AnzioWin under various Windows emulation products for the Mac. Check out our knowledgebase article on Running Anzio on a Mac for more information.



      
          

      

  







    

  
      
          
        
           Do we support iPad, iPhone, Android, Windows Phone, Windows Mobile, Windows CE, Embedded CE, or other smart phones?

        
          

        

        
          
          
            Anzio Lite and AnzioWin are Windows-only applications and will not run on  Windows CE, Windows Mobile, Windows Phone, or other mobile "smart" devices. These devices' small screens would make them very tedious to use for full-screen applications.


We also do not have a product for the iPad or iPhone, or for any Android device.


We have no current plans to develop for any of these devices.


You might consider, instead, a Windows based tablet. Another option is to run a remote desktop application, such as GoToMyPC or LogMeIn on the device, in order to connect to your office PC. On that PC, run Anzio.



      
          

      

  







    

  
      
          
        
           Do you offer site or concurrent licenses?

        
          

        

        
          
          
            	Our normal licensing for Anzio Lite and AnzioWin is a per PC license. Additionally we offer a concurrent-use license. However this requires that you have your own license management software already in place. Concurrent use license would allow you to run a specified number of Anzio Lite or AnzioWin sessions at any one time, but have the ability to install the software on an unlimited number of machines. Concurrent use licenses are 40% above the cost of a normal user license.


	At present we do not offer any enterprise-wide or site license options. We do offer aggressive quantity discount licenses however. If you have a specific need for more than 100 copies, give us a call for a discounted price. 



      
          

      

  







    

  
      
          
        
           Does Anzio Lite support keyboard remapping or macros?

        
          

        

        
          
          
            Anzio Lite does not support creation or changing of keyboard mapping, macros or scripting of any type, beyond loading a "keys file" which normally defines what should be sent by special keys according to the terminal type which Anzio is emulating. AnzioWin, on the other hand, contains all these capabilities.


Anzio Lite can use keymaps and simple macros created by AnzioWin. It is common for an administrator to have one license to AnzioWin, while other users have Anzio Lite. The admin can then create a set of custom key definitions, save them to a "keys file", and then propogate that file to other users, where their Anzio Lites can use them.


(Keymapping and macros are essentially the same thing in Anzio.)


 



      
          

      

  







    

  
      
          
        
           Does Anzio support SCO UNIX 'mscreen'?

        
          

        

        
          
          
            	Yes it does, but there is a little more to it than that. Within SCO, the terminal type dictates if 'mscreen' will work properly. See our document on Using Anzio with 'mscreen'.



      
          

      

  







    

  
      
          
        
           How can I get the standard terminal beep?

        
          

        

        
          
          
            	It is not uncommon for the host to generate a beep for certain events. Anzio Lite and AnzioWin both utilize the default sound settings in Windows. But what if you do not have speakers hooked up? You can go to Advanced Options and force Anzio to use the PC Speaker, rather than whatever default Windows has set. Check out our Sound Support page for more information. In early versions of AnzioWin and Anzio Lite, we added support for sound cards in those cases where there was not a PC speaker. In order to do this, we utilize some of the Windows Theme sounds. In Windows XP and later versions of Windows 2000, a sound for a theme may no longer exist in that theme. Look in "Advanced Options" under the Edit menu and see what the "Beep Type" is set for. If it is set for "400" or "440", and you are having problems with AnzioWin / Anzio Lite freezing or hanging up, try changing selecting a different sound.



      
          

      

  







    

  
      
          
        
           How can I move Anzio to a new PC?

        
          

        

        
          
          
            If you are adding a PC, you need to buy an additional license. Every PC that runs Anzio needs a license.  You can order additional licenses for Anzio Lite or AnzioWin by contacting your reseller,  through our online order form, or calling us at 503-624-0360.


If you are replacing a PC that died, reinstalling Anzio onto a repaired or restored PC, or moving a license away from a PC that will no longer be used for Anzio, you can simply install the old license (activation) code. If you no longer have the license information, feel free to contact us; we can look it up.


A license is for a particular major version. That means if you have a license for version 16, it's good for 16.anything. We always recommend you install the latest version you're licensed for. So if your license is for 16, install the latest 16.anything, which is 16.3m.


Note that if you are moving to a newer Windows, you may need to update your Anzio to a later version in order to be compatible. In particular, Window Vista or 7 will need Anzio v16.3 or later and Windows 8 or 10 requires Anzio 17.0 or later. You can order updates online or by phone. Then install the latest 17.anything.



      
          

      

  







    

  
      
          
        
           How can I move configuration settings for Anzio from one PC to another?

        
          

        

        
          
          
            	The easiest way to do this requires a USB memory device, often known as a "thumb drive". Bring up Anzio Lite or AnzioWin on a PC where it works properly. Insert the thumb drive in a USB port on that PC, and note its drive letter. In Anzio, go to the File menu, then click on "Save settings as" (or "Save defaults as").  In the File Save dialog that pops up, navigate to the thumb drive, and save it there with a ".DEF" file extension.


	In the "tray notification area" in the lower right part of the Windows screen, find and use the item to "safely remove" the thumb drive. After Windows gives its OK, remove the thumb drive.


	Go to the new PC (or the one having problems). Insert the thumb drive. Bring up Anzio Lite or AnzioWin. Click on the File menu, then "Import settings". Navigate to the thumb drive, find the settings file, and click "Open". Anzio will read those settings into memory, and prompt you to restart Anzio. Say "Yes". You'll be prompted to save your settings on the hard disk of the PC -- do so. That should take care of it, although you may want to check your Printer Setup settings.


	(If your File menu doesn't contain "Import settings", you are probably due for an update to Anzio.)



      
          

      

  







    

  
      
          
        
           How can I remote print from UNIX without passthrough printing?

        
          

        

        
          
          
            	In the terminal emulation world, such as what is supported with our Anzio products (serial, telnet or SSH), remote printing was most often done by passthrough printing, where the print job would "pass through" the terminal session to the locally attached printer. Host applications often supported this as well as the terminal client.


	Other types of printing were also supported by the host application and the host itself, namely printing to a spool or queue on the host for the local printer. The UNIX could also be set to print through the LPR or LP program which could then be redirected to remote printers or remote print servers.


	Print Wizard supports three types of printing that works with these approaches, Despool, LPD and Listen.

	
		Listen watches for remote print jobs coming in as raw data on port 9100, similar to Hewlett-Packard's ® JetDirect protocol.
	
		LPD utilizes the LPR / LPD protocol for capturing print jobs destined for a remote print server.
	
		Despool, and the FTPDespool variation, watches for remote jobs posted to a specific location. While Despool watches a locally mounted directory, such as over SMB or NFS, FTPDespool can watch a remote directory over the FTP protocol.



      
          

      

  







    

  
      
          
        
           How can I remote print from UNIX without passthrough printing?

        
          

        

        
          
          
            	When you have a host application that does not support passthrough printing (printing that goes through the Anzio telnet session), your options are somewhat limited.


	The most common approach is to set up the LPR/LPD protocol to do the remote printing. This works by acting as a back channel from the UNIX spooler to redirect the output through LPR on the host to an LPD server (daemon) on the PC. With our standalone Print Wizard product, we provide PWLPD which is a robust LPD for the PC.


	The second approach is to use netcat (freeware for UNIX), netprint (our product included with Print Wizard also) or H/P JetAdmin for UNIX. H/P JetAdmin redirects to the output from the UNIX to a specific printer attached to the network with a JetDirect device. Netcat simply dumps data to port 9100 at another IP (the data can then be captured and printed). Netprint is a UNIX utility included with our Print Wizard standalone product that sends data from UNIX to the PC's printer using port 9100 and Print Wizard on the PC.


	The catch: These products work fine as long as the remote user's IP address is known in advance (a static IP). However if the user is coming in over the Internet from an ISP, the dynamic IP will change each time. To solve this problem, it is easiest to have a login script that runs which modifies the LP print queue for a specific user during a specific session. It can be a pain to set up, but works smoothly once done.


	Our netprint program, though, does have the ability to determine dynamically what IP you're coming in from, and route a print job to that IP address, where you can have Print Wizard running.


      
          

      

  







    

  
      
          
        
           How can I set up Anzio to run from a terminal server / file server?

        
          

        

        
          
          
            AnzioWin and Anzio Lite work well with terminal servers and in running them from file servers. However, do remember that AnzioWin and Anzio Lite licenses are on a per PC user. On a file server or terminal server this refers to the number of nodes that will have access to the server.


In order to set AnzioWin or Anzio Lite up to run from the server, install the product on the server and permit access to the users. That's it! Well almost. Two things that may be a headache:



	Anzio looks for its default file, called AnzioWin.def, within the Anzio program's home directory. You can set every user up to use this default file by simply saving it as you'd like and then marking the file as "read-only" so not everyone can change it and affect others. OR you can set up individual anziowin.def files in user directories and when you create the shortcut, include the file name (see 3 below).
	Anzio requires a registration/activation license code in order to run. You can purchase individual licenses for each user, one quantity license to share among each user, or you can install the license on the server (saving from having to enter it for each user). If you wish to do this last option, give us a call and we can let you know how to do set it up for a server.
	You do need to create the shortcuts on each users desktop. With most server software, you can do this easily. If you need to give each user access to their own default file, it may take a little more work. A shortcut can point to individual default files by doing



<executable name>  <default file name>


  such as


f:\anzio126\anzio32r.exe $UserHomeDir\anziowin.def





      
          

      

  







    

  
      
          
        
           How can I tell Windows to stay connected to my host, it acts like it is timing out?

        
          

        

        
          
          
            Anzio, and telnet in general, is a connection oriented protocol, requiring the connection remain up during a session's duration. However, network devices, traffic, auto-disconnects, etc., can cause the connection to be lost. Neither Anzio nor Windows has an auto-disconnect feature, but are dependent on the network staying active.


 


Sometimes you can fine tune the TCP/IP parameters to not respond quite so quickly or to retry more often before determining a connection as severed.


With the latest versions of Anzio Lite and AnzioWin (version 12.5 or later), you can also set an option that will occasionally send a single keep-alive packet to the host. In most cases this will work fine in keeping a connection open, especially over the Internet. However, remember that in doing this you are actually hiding some other issue that may cause problems down the road.


This option can be set in version 12.5 by doing a hexpatch command to the default file:



	f                                                   (to get to the Function line)

	HEXPATCH 18c2 05


To use this feature in version 12.6 or later, go to Communicate:Network:Stay Alive, and enter an interval in seconds.



      
          

      

  







    

  
      
          
        
           How can my application cause 1 print file to print to multiple sources?

        
          

        

        
          
          
            	It is possible to script all uses of the Print Wizard engine such that the user does not know what is happening.

	
		From your own application or user script, you could set up Print Wizard to run multiple times against the same file, simply by preserving the file between runs.
	
		You could set a script up that runs Print Wizard once to format a file to a specific type, such as creating a PCL file, then use Print Wizard to reprint it, fax it, email it, etc.
	
		From the PWLPD or PWListen program, you could run a script upon receiving the file that would manipulate the file and output it to numerous sources (set up a Custom Program for output).
	
		From a Print Wizard print profile, you can define a "By Custom" profile that actually ran a script that runs the Print Wizard engine several times instead of once for the file specified.



	There are lots of options here. Call if you have a specific need.


      
          

      

  







    

  
      
          
        
           How do I configure Anzio Lite or AnzioWin?

        
          

        

        
          
          
            Anzio (meaning Anzio Lite or AnzioWin) normally requires only a small set of configurations to run, notably a) terminal type to emulate, b) communication method, and c) host name or IP address. When you start Anzio for the first time, it will ask you these things in this order. How should you answer?


Your first, best source for this information is the technical support for the system you will connect to with Anzio (that's not us). Your application package may require a certain setting for terminal type. Your company IT should know the communication method (usually SSH or telnet) and host name or IP address. We do not know this information.


If you are updating an Anzio on the same machine (moving from an earlier version to a later version), and the old version was configured to work well, you can migrate the setting file. Run the old version; go to the File menu and select "Save settings as"; and select an easy location. The name of the settings file is usually "anziowin.def". (Avoid saving anywhere within "Program Files".) Now run the new Anzio. It will ask if you want to import a settings file. Say "yes", and navigate to this location, and open the settings file.


If you have a different PC on which Anzio is working well, you can migrate the settings file from that Anzio to the new PC. On the working PC, run Anzio. Go to the File menu; select "Save settings as", and navigate to a "thumb drive" (a removeable USB memory device). Save the file there. Dismount the thumb drive, take it to the new PC, and plug it in. Run Anzio on the new PC. When asked "Do you want to import a settings file", say "Yes", and navigate to the thumb drive. Open the settings file.


If you have already made a try at configuring Anzio, and saved those settings, Anzio will not ask you the "import" question. Instead, go to the File menu and select "Import settings file".


In any case, Anzio will prompt you to save the settings to a new file in a standard location. Take the defaults.


These instructions should work even between Anzio Lite and AnzioWin, and between version numbers.



      
          

      

  







    

  
      
          
        
           How do I create a PCL file?

        
          

        

        
          
          
            	The simplest way is to lay out your print document and print to a PCL 5 or earlier printer driver. When you do this, go into the printer driver and select "Print to file". It should ask you for a file name that can then be saved off for future use.


	Even if you do not have a PCL printer, you can install a PCL printer driver to generate print files from. Do an "Add printer" and select an H/P printer that supports the level of PCL you want. Then set the "Print to file" flag and use it to print through. The PCL file can then be used for subsequent printing, for overlays or for other reasons.


      
          

      

  







    

  
      
          
        
           How do I create a PDF?

        
          

        

        
          
          
            The Print Wizard engine allows you to convert any printable file into a PDF file by simply printing it with the appropriate switch settings:



	Printwiz.exe /pdf /fFilename.pdf myfilename

	Printwiz.exe /fpdf:// myfilename

	Printwiz.exe /fpdf://myfilename myfilename


You can also generate PDF files through the user interface menu items.



      
          

      

  







    

  
      
          
        
           How do I create a SPL (spool) file?

        
          

        

        
          
          
            	This is not as easy as creating a PCL file. A SPL file is created when a print job spools out what is called EMF files to the printer spooler.


	First locate the spool directory, usually "\windows\system32\spool\printers". Under Windows NT, it may instead be "\winnt\system32\spool\printers" or "\winnt\SYSTEM\CurrentControlSet\Control\Print\Printers". On some versions you can configure Windows to use a different directory for all printers, or for a specific printer.


	To find your PC's general spool directory:

	
		Go to the Control Panel
	
		Click on "Printers" or "Printers and Faxes"
	
		In the File menu, click on "Server Properties"
	
		Click on "Advanced"
	
		Note what is in "Spool folder".



	If in the steps below you fail to find a particular spool file, you may want to check the Windows Registry, under one of the following areas:

	
		HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Print\Printers\DefaultSpoolDirectory
	
		HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Print\Printers\specific printer name\SpoolDirectory



	Now capture the SPL file.

	
		Open the Control Panel's "Printers" or "Printers and Faxes" applet.
	
		Double-click the icon for the printer in question. Ideally, there will be no print jobs showing.
	
		From the Printer menu, choose "Pause printing".
	
		Print the document you want to capture, on the chosen printer, using whatever Windows software is appropriate. You should see the print job show up in the printer window on your screen.
	
		Look in the spooler directory as identified previously. You should find a file with a ".SPL" extension (hopefully only one). Copy this file to some other location on your computer.
	
		In the printer's window, cancel the print job.



      
          

      

  







    

  
      
          
        
           How do I do user macros in Anzio Lite?

        
          

        

        
          
          
            User macros are created and edited using AnzioWin. While Anzio Lite does not support remapping itself, if these are simple macros (with no non-Anzio Lite commands), Anzio Lite can use macros set up by AnzioWin. So you would need at least one copy of AnzioWin to do the macros and then distribute the modified key file containing the macros to the Anzio Lite users.



      
          

      

  







    

  
      
          
        
           How do I include attachments with my email? 

        
          

        

        
          
          
            In the case of email, all files are sent as attachments. You can also specify additional files by browsing for them when using the Email Form input screen (through both the user interface and the Print Wizard engine), or by specifying it on the command line for the Print Wizard engine:



	printwiz.exe /email=abc@def.com /ac:\temp\file.doc myfiletoemail


Different behaviors may be noticed with different email options. Contact us for more information.



      
          

      

  







    

  
      
          
        
           How do I include PWML in my file?

        
          

        

        
          
          
            PWML, Print Wizard Markup Language, can be added to the beginning of any file directly in the data stream or by specifying a PWML print "init" file. Print "init" files can be specified in a print profile file as well, or can be referenced on the command-line for the Print Wizard engine to use:


C:\Program files\Printwiz30\printwiz.exe /vinit=myinit.txt myfiletoprint



      
          

      

  







    

  
      
          
        
           How do I install Print Wizard?

        
          

        

        
          
          
            You can download the Print Wizard installation program from our web site, or order it on CD. Run the setup program in order to install Print Wizard on your Windows PC. It is as simple as that.


Setting up Print Wizard may involve a little more time however. You do need to know what you are going to be using Print Wizard for and how you will be printing through it. There are also numerous examples included that will help you determine what Print Wizard is capable of.


When you run the install program, you end up with a desktop icon for Print Wizard. This is the user interface and will give you the opportunity to set it up the various options available, include the services you may want to run.


Refer to the Print Wizard manual for more information on using Print Wizard and Print Wizard services.



      
          

      

  







    

  
      
          
        
           How do I set Anzio up to access multiple hosts?

        
          

        

        
          
          
            See our document on Using Anzio to Connect to Multiple Host Systems. This will describe how to set Anzio up for multiple host connections.



      
          

      

  







    

  
      
          
        
           How do I setup email and email defaults?

        
          

        

        
          
          
            	From the Print Wizard user interface, under the Tools menu, you can set up email options as well as the default email method to use. Check mark the default email method that you want as the default.



      
          

      

  







    

  
      
          
        
           How do I setup faxing and default fax?

        
          

        

        
          
          
            	From the Print Wizard user interface, under the Tools menu, you can set up faxing and the default fax method to use. Check mark the default fax method that you want as the default. You can usually determine if any fax software is loaded by looking at your Control Panel : Printers and Faxes to see if any fax drivers are available (as an example a printer driver called "fax" on Windows XP and later is usually referred to by us as "fax32", whereas one called "WinFax" or "WinFax (Photo Quality)" is usually Symantec's WinFax Pro).



      
          

      

  







    

  
      
          
        
           How do I setup Localhost printing?

        
          

        

        
          
          
            Localhost printing refers to printing through the PC to a local port on the PC as if this PC was a remote printer. Print Wizard supports this by setting up a loop back printer, one that prints out a network port to itself. Refer to our support document on Localhost printing to configure a local printer to do this.



      
          

      

  







    

  
      
          
        
           How do I use the Print Wizard DLL?

        
          

        

        
          
          
            The Print Wizard DLL is designed to interact with the many features of Print Wizard through program calls. These program calls are made by your own Windows program or script and result in Print Wizard doing all the print work for you. Check out our documentation on Using the Print Wizard DLL.



      
          

      

  







    

  
      
          
        
           How does passthrough printing work?

        
          

        

        
          
          
            Passthrough printing allows a host computer to send a print job through the user's terminal (emulator) and out to an attached printer. It is sometimes called "local print", "attached print" or "slave print". This means the user must be logged in to the host. The host then sends a sequence of characters that causes the telnet or terminal emulation software to redirect its output to a local printer until a similar sequence is received to turn off the passthrough printing. In our document library we have an excellent document talking about passthrough printing, how your host support should be set up and how Anzio works. See the A Guide to Passthrough Printing document for more information.



      
          

      

  







    

  
      
          
        
           How does Service Edition licensing work?

        
          

        

        
          
          
            Print Wizard version 4.0 and later includes all the necessary support for Print Wizard Personal Edition and Print Wizard Service Edition (formerly called Server Edition). When you run Print Wizard as a demo (60-day evaluation), the program assumes you are working on a Service Edition and all options are available to you.



Once you enter a license code for the Personal Edition, Foreground Services, Windows Services, and a few more features become unavailable. You must have a Service Edition license to utilize these Services.



The basic Print Wizard Personal Edition (PE) license supports up to 3 output devices (printers, faxes, pdf) that it can print to at any given time. If you have additional needs, contact us for further licensing options.



The Print Wizard Service Edition (SE) license supports a specific number of output devices (printers, faxes, pdf) available to the print server, depending on the license you purchase:


	
PW SE 3 -- Support for up to 3 output devices
	
PW SE 6 -- Support for up to 6 output devices
	
PW SE 10 -- Support for up to 10 output devices
	
... and so on. See pricing page for more info.




Both Print Wizard Personal Edition and Print Wizard Service Edition are licensed on a per machine basis. That means every PC on which Print Wizard runs must have a license.



 


      
          

      

  







    

  
      
          
        
           I am generating PDFs with AnzioWin. How can I now email these?

        
          

        

        
          
          
            Beginning with version 16.0c of AnzioWin, you can now setup a reference to an email server and method and email generated PDF files or TIF files as they are completed. AnzioWin supports CDO, MAPI, OUTLOOK and the SMTP email protocols. Each have an advantage, but each also depends on a) what type of email client on the PC you are working with and b) whether your email server allows relaying. Check out our document on AnzioWin PDFs, TIFs and Emailing Print Jobs for more information.



      
          

      

  







    

  
      
          
        
           I am getting a printer error.

        
          

        

        
          
          
            	Printer errors, especially those in the 5000 range, usually indicate that we are sending data to the printer that the printer cannot understand. A good example would be sending PCL codes to a non-PCL printer or sending Okidata escape sequences to an H/P Laserjet, or sending raw data to a Windows-only-printer.


	By default, the Print Wizard engine will determine if the file contains printer-specific escape sequences and then try to send the data in either spooler or raw print level. Many Windows-only printers cannot accept raw data and this will cause a printer error.


	Likewise, if Print Wizard determines the file has Okidata escape sequences in the data stream, and you try to print it on an H/P Laserjet, the printer driver will generate an error.


      
          

      

  







    

  
      
          
        
           I am having problems with ZModem, XModem, YModem and Anzio, why?

        
          

        

        
          
          
            First off, see our document on Using ZModem in Anzio. This will describe some of the problems associated with ZModem file transfer.


One thing to remember with the Zmodem, protocols (including Xmodem and Ymodem) is that they are old protocols designed to work over serial connections.


Commonly what we see is that someone is running Zmodem, Xmodem, Ymodem over a network connected Anzio and expecting it to work as it would over a serial connection. In about 75% of the cases it may work great. But in the other 25% of the cases, these protocols fail and usually fail badly. There are several contributing factors to this:


	network drivers - the network speed, how network traffic gets routed and buffered internally
	the X-ON/X-OFF protocol for controlling packet loss
	issues with dropped packets and getting out of synch
	problems with numerous releases and whether the one on your system has been updated to work over a network



You can play with parameters in Anzio, namely windows and buffer sizes, and you may be able to get better functionality out of it. Check with the vendor of the operating system and ask if anyone is running these protocols over network connections. However, we recommend using FTP for network file transfers. You will find FTP about 200% faster and more reliable for moving files between systems.



      
          

      

  







    

  
      
          
        
           I am having trouble with "ftpput" and "ftpget" in a script.

        
          

        

        
          
          
            User macros are done through AnzioWin with a specific syntax in most cases. The usual problem with the ftpput, sftpput, ftpget and sftpget is the missing host parameters. Currently the host parameter IS NEEDED. This may change in the future, but for now it must be included. However, it can be an empty string such as the following:



/usr/bin/printf "\034%s\035" "ftpput \"\" c:\\temp\\mytest.pdf"




The double-quotes in the command represent the host name and force AnzioWin to use the actual PC file name (without the directory information). Also note that you may have to escape the backslashes in this string, depending on your shell and scripting. You can provide the host name if you wish:



/usr/bin/printf "\034%s\035" "ftpput mynew.pdf c:\\temp\\mytest.pdf"




Another common problem is understanding that you MUST log in before performing a file transfer over FTP. One advantage you have with AnzioWin, if you have the login wizard enabled and a username and password included, the login for your FTP or SFTP will be automated when doing transfers through scripts. An alternative is to provide the host login information within the file transfer string itself (password can be optional if one is not required by your ftp server):



/usr/bin/printf "\034%s\035" "ftpput username[:password]@hostname/hostfilename pcfilename"




An example might look like this:



/usr/bin/printf "\034%s\035" "ftpput jdoe:fido123@server2/mynew.pdf c:\\temp\test.pdf"




The other, most common problem is using wildcards and understanding how this works. The minimum syntax for "ftpput" and "sftpput" requires the PC file name:



ftpput "" <PC filename>




The PC filename can be a wildcard or a list of files to transfer:



ftpput "" c:\temp\*.pdf


ftpput "" c:\temp\myfiles.*


ftpput "" c:\temp\inv-????.pdf


ftpput "" c:\temp\inv-0020.pdf,c:\temp\inv-0021.pdf,c:\temp\inv-0022.pdf




(remember that you may have to escape the backslashes and enclose the file names in quotes if there are any embedded spaces).


In doing WILDCARDS or a file list, you also need to be aware that the host name should either be left empty or it can be a directory on the server. You must have write permissions for the "put" to be performed to a specified directory. A list of file names to transfer "as" is not supported at this time.


For server file transfers, sftpget and ftpget, you can also specify a set of wildcard strings, similar to those above. And like the above, the PC file name should be left blank or be a directory name with write permissions. A list of file names to transfer "as" is not supported at this time.


In both cases, if you do not specify a host or PC directory (depending on the upload or download direction), the default will be used. For putting files on the host, the upload default directory is the first directory logged into with your username and password. For the PC download default directory, the directory is that specified in the "Transfer Options". If none is specified, the current working directory is the default.


Note - Wildcard transfers first appeared in AnzioWin version 15.2j for sftpput and sftpget. AnzioWin versions later than version 16.2 supports wildcards in the FTP protocol as well (ftpput and ftpget). Please contact us for more information if you are having problems and want to use this feature.



      
          

      

  







    

  
      
          
        
           I cannot get AnzioWin to give correct file names (dir/s, ...) to my host script

        
          

        

        
          
          
            The problem is not usually AnzioWin in this case. The problem is the handling of backslashes by the shell you are running under for your operating system. Since backslashes have special meaning in most all shell strings, they have to be either escaped or handled special on input and output. Try something like the following (this may vary depending on your shell and scripting environment):



/usr/bin/printf "\034%s\035" "dir/s c: "

read -r file

printf "%s\n" "$file"

file="${file//\\/\\\\}"

/usr/bin/printf "%s\n" "$file"




The "-r" is necessary on the read to not strip the backslashes and if you need to redisplay the file name with just an echo or use it within other variables, the "file=..." string will escape the backslashes for you.


There are a couple of commands that will help in situations where you continue to have problems with backslashes.


First, you can set the default directory separator character (a backslash) to be something other than the Windows default with the "dir-separator" command.



/usr/bin/printf "\034%s\035" "dir-separator | "




You will then get back a file name with that character separating the path directories, i.e. c:|myfolder|myfile.pdf.


Additionally, when a dir/s, findfirst/s, findnext/s or other directory commands fail or are completed, they return, by default, a double-backslash, i.e. \\. This too can be difficult to work with on some hosts. So we have a command to adjust this as well, the "dir-terminator" command.



/usr/bin/printf "\034%s\035" "dir-terminator DONE "




In this example, instead of a double-backslash being returned when a directory command is complete (or fails), the word DONE will be returned.


More information can be found in the AnzioWin manual and whitepapers, as well as in the readme.txt file shipped with each version of AnzioWin.



      
          

      

  







    

  
      
          
        
           I get nothing or a Printer Dialog Error, but other applications under Windows print fine.  What's wrong?

        
          

        

        
          
          
            	There is an increasing number of printers and printer drivers hitting the market for Windows. Also, there are an ever-increasing number of applications which manipulate the printer driver. While we do attempt to support all options, we have found that certain applications "mess" with the printer control record causing Anzio's setup to become corrupt. Once the default file becomes corrupt, there are two possible fixes.


	First, if you have more than one printer installed under Windows, go to Printer Setup and choose a different printer, save defaults and try printing (if this is an option).  Then return to the printer with the problem, save defaults again and try printing.


	Second, if the first is not an option or does not work, is to create a new defaults file. Make sure you know the default file name you are using, i.e. anziowin.def, the keys file being loaded, i.e. vt220.kys, and your communications setup options. Go to the File:Run or Start:Run dialog box and enter the executable name followed by the word NONE. This will start Anzio without a default file. Go through the setup procedure and log back in to your host. Select the printer again under Printer Setup and attempt to Print Screen. If it's ok, be sure to re-save the defaults under the correct name. If this fails, give us a call.


      
          

      

  







    

  
      
          
        
           I got a Winsock error number, what does it mean?

        
          

        

        
          
          
            These errors are from your WinSock software and usually represent either a network problem or a misconfiguration in the windows TCP/IP setup (go to Control Panel : Network). A complete list can be found at Sockets.Com Winsock Error Descriptions. All other errors can be found in the Anzio manuals, README files or on-line documentation.



      
          

      

  







    

  
      
          
        
           I lost my license activation code. What can I do?

        
          

        

        
          
          
            You can contact us to look up and send you your license information. We will need the company name it was purchased under. If you have the serial number, please provide that. If you know you purchased through a reseller, please provide that information.


However, we would encourage you, in this situation, to purchase an update to the current version. For Anzio Lite, one copy is only $20. In fact, if you have moved to a Vista or Windows 7or 8 PC and you had a license earlier than 16, we will require you to update, as earlier versions of Anzio are not supported on these later versions of Windows.


You can order updates online. Be sure to indicate that they are updates.



      
          

      

  







    

  
      
          
        
           I suspect I have a corrupt default file, but cannot get rid of it

        
          

        

        
          
          
            Anzio uses a settings file that typically has a ".def" extension. The default name of the settings file is "anziowin.def" (even if you're using Anzio Lite). If you have reason to believe that your settings file has been overwritten or otherwise changed, the easiest way to resolve that problem is to rebuild the settings file.


From the Start button or desktop, select "Anzio... (new connection)". When prompted to import a settings file, answer "No". Answer the configuration questions as they are asked. Complete your connection. Exit from the host connection and quit Anzio. When prompted to save settings, do so.


Note: the company that provides or supports the host application (that Anzio connects to) might have told you what you should select for various settings, especially "Terminal type" and "Host name or IP address". We recommend you follow their instructions.


There are several files that get installed and uninstalled through the AnzioWin and Anzio Lite setup program.


	Extension or Filename	Description
	.exe	The executable, such as anzio32.exe
	.dll	The language resource module DLL's
	.cap	Terminal capabilities files
	.trs	WordPerfect for UNIX terminal definition files
	.dat	Unicode character data files
	.uni	Character map files
	.hlp	Anzio help files
	.prt	Print Wizard definition files (AnzioWin only)
	.c	C program examples of simple download and upload

			(AnzioWin only)
	download	An example script for downloading
	.tic	Terminal definition tic files
	printwiz-samples\	Sample Print Wizard print jobs (AnzioWin only)



As long as you are working in English and under a standard Windows code page, the only file really necessary to run AnzioWin or Anzio Lite, is the executable file.


 



      
          

      

  







    

  
      
          
        
           Keyboard remapping?

        
          

        

        
          
          
            	Keyboard remapping is done through AnzioWin. While Anzio Lite does not support remapping itself, it can use a remapped keys file. So you would need at least one copy of AnzioWin to do the remaps and then distribute the modified key file to the Anzio Lite users.


	AnzioWin key remapping is done similar to setting up macros. See our various support documents and knowledgebase articles for more information.



      
          

      

  







    

  
      
          
        
           LPD fails with winsock error

        
          

        

        
          
          
            Winsock errors normally come from some network problem that has occurred. Most often causes fit into two different categories: hardware (bad network cards, bad cabling, network down, ..) and software (firewall blocking inbound traffic, Internet security software blocking inbound traffic, personal firewall blocking port traffic, software already using a specific network port, .).


If network traffic seems normal, i.e. your web browser seems to be working, the most common problem is software related. Two major problems occur frequently, there is some security software blocking inbound and outbound network port traffic, or there is some software already using the network port Print Wizard Services, such as LPD needs.


Personal firewalls and internet security suites, such as McAfee or Symantecs, or Microsoft's own Windows firewall maybe blocking port traffic for the LPD service.


The best first test is to disable the firewall portion of your security software and see if the LPD service will run. If so, turn back on the firewall or security software and check to see if you can add the network port to an exceptions list, or add the Print Wizard program to the application exceptions list (PWLPD.EXE for Print Wizard Service or PWSERVICES.EXE for the Windows Service).



      
          

      

  







    

  
      
          
        
           My overlay does not fit the page.

        
          

        

        
          
          
            	Specific printer and printer drivers have differing unprintable areas. Along with this, there are also the issues of margins. Some of this can be controlled by PWML code in an "init" file, or by setting items in the printer driver itself. Getting overlays to fit properly can be a chore. We can help. Give us a call and we can usually come up with a solution.


      
          

      

  







    

  
      
          
        
           My overlay is not printing cleanly.

        
          

        

        
          
          
            	Overlay files either need to be in the format of a PWML file, a PCL file or a graphics file (TIFF, JPG, GIF, WMF or BMP). The problem with the graphic file formats is they may not appear clean if they were not scanned or created at the proper resolution for the printer, including the proper offsets for margins, etc. This may be a problem if you plan on moving this overlay between specific printers. A better approach is to utilize a PCL file if you can.


	Another possibility is laying out the overlay with PWML (Print Wizard Markup Language). This may help you come up with a much cleaner overlay file.


	If you do continue to have problems or want some help with PWML, give us a call.


      
          

      

  







    

  
      
          
        
           My serial number / activation code says it is invalid.

        
          

        

        
          
          
            	First, make sure you have the right version of the program and the right program. A serial number and activation code for Anzio Lite 15 will not work with Anzio Lite 16. Likewise a serial number and activation code for Anzio Lite will not work with AnzioWin.


	Second, if you are running on Windows NT, Windows 2000 or Windows XP and your program continues to tell you it is a demo or continues to show the opening splash screen with the countdown, even after entering the registration information correctly, then try logging in as an "Administrator" and then installing Anzio. Limited and restricted users may not have write permissions for the Windows registry.


	If you are running on Vista, Windows 7, or Server 2008, try running Anzio "elevated"; that is, "as administrator". To do this, right-click on the desktop icon, then select "Run as administrator". Note that this is different from running as a user with administrator privileges.


	Lastly, "Reg error" or "Registry error" indicates that either the user you are logged in as does not have Windows registry "write" permissions, or the registry is locked in some manner.

	
		If you are running as a restricted user, try logging and entering the license information under an Administrator login.
	
		If you are using remote registries, be sure you have permission to do this task; you may have to do this from your domain controller or server as Administrator.



      
          

      

  







    

  
      
          
        
           Old default files seem to be left behind even after I uninstall Anzio

        
          

        

        
          
          
            See "How to remove a corrupt file"



      
          

      

  







    

  
      
          
        
           SFTP versus FTP, what are the differences?

        
          

        

        
          
          
            	FTP is the "file transfer protocol" most often used over the Internet. It is even used by most browsers when doing downloads. Starting in version 12.6 of AnzioWin, we included an integrated FTP client that could auto-login to a host, transfer files and provide some user feedback. It could also be used within macros and scripts for AnzioWin.


	AnzioWin version 15 introduces SFTP support, FTP over a Secure Shell connection. SFTP encrypts all its data and control sequences during a SFTP session, just as SSH would for a terminal session.


	There are major differences however. FTP actually runs utilizing the Windows "wininet" routines and requires opening a separate network connection to the host requiring a separate login and password be entered again (though AnzioWin can do this in the background). This also means your firewall must allow FTP connections in and out.


	SSH SFTP does not require a separate login, does not require a new network connection and does not require access through a firewall. SFTP works over a "back-channel" of SSH, running in the background of the same SSH session you are currently logged into.


	More information can be found in the Anzio manual, How-To and Read-Me files, and in our support pages at our web site.


      
          

      

  







    

  
      
          
        
           The function keys are not behaving as they should.  Why not?

        
          

        

        
          
          
            	The common problem here is that the currently loaded keys files does not match the current terminal type. Check under the "Communications" menu to see what Terminal Type you are set for. Then go to the "File" menu and do a "Read Keys" and select the corresponding keys file. Be sure to save defaults after this so that the proper keys will be loaded next time.


	Another possible problem is that you need to remap a key or key sequence. This can be done with all Anzio products except Anzio Lite. Once a key is remapped, the key file can be used by Anzio Lite.



      
          

      

  







    

  
      
          
        
           What are bang commands?

        
          

        

        
          
          
            "bang" commands are commands that can be included in a data stream that will change the behavior of Print Wizard in printing a portion of a file. Bang commands are discussed in detail in the Print Wizard manual.


You can split your data into multiple sections to be processed separate from other sections by including bang commands directly in the data stream. As an example, if I wanted to create a PDF of part of a file, fax another part of a file and email another part of a file, I could do this within one print job with bang commands.



	!PDF /fmypdf.pdf

	Line 1 of data

	Line 2 of data

	Line 3 of data

	!fax /x5036240760

	Line 1 to fax

	Line 2 to fax

	Line 3 to fax

	!email /eabc@def.com

	Line 1 to email

	Line 2 to email

	Line 3 to email

	 



      
          

      

  







    

  
      
          
        
           What are Print Wizard profiles?

        
          

        

        
          
          
            	Print Wizard version 3.0 introduced a new concept of 'print profiles'. Print profiles are settings that will be applied for each subsequent print job that includes that profile as a parameter.


	Print profiles include information such as the printer to use, the various printer settings, number of copies to print, whether to print it, fax it, email it, etc. These can all be set up in the user interface by settings things the way you want and then saving your current settings, or by creating a profile from default settings and saving it.


      
          

      

  







    

  
      
          
        
           What are Services?

        
          

        

        
          
          
            Services are programs that run in the background and "watch" for events to happen. In the case of Print Wizard, this involves watching either for a print job to show up in a specific directory (despooling), or watching for a job to arrive over a network port.


Print Wizard supports two types of services, Foreground Services (previously known as Print Wizard Services) and Windows Services.

	
Foreground Services are those that are run by a specific user, when logged in, watching for print jobs to appear. This does require the user to log in and start the Print Wizard Service. Alternately you could add the service to the Windows Startup folder and it would run in the background whenever the user logged in.
	
Windows Services for Print Wizard are run from the Windows registry whenever the machine is actually booted up (you do not need to log a user in). These services are available for all users and will receive remote print jobs even if there is no user logged in. They normally run as a "Local System" user with very little permissions.



Both services are managed through the Print Wizard user interface. Refer to the Print Wizard manual for more information.



      
          

      

  







    

  
      
          
        
           What do I do if Anzio won't connect?

        
          

        

        
          
          
            If you are on a PC that has connected before from the same location, to the same host system, the problem is almost certainly outside of Anzio. The server (host system) you're trying to connect to may be down. A new firewall may have been installed, either on your PC or at the host end.


If several PCs in your office stop connecting to the same host system, it is even more likely that the problem is on the server. See above.


If you are trying to connect to your own office from home for the first time, and nobody else has done that before (from outside the office), the office may not be configured right. Many things need to be in place at the office for that to be possible and secure. Your best bet is to use a local network consultant.


If you don't know who runs the system you're trying to connect to, we don't either, and we can't help you with that.



      
          

      

  







    

  
      
          
        
           What files are necessary to run AnzioWin or Anzio Lite?  What files get installed and where?

        
          

        

        
          
          
            See "How to get rid of a corrupt file"



      
          

      

  







    

  
      
          
        
           What is Smart Print?

        
          

        

        
          
          
            	Print Wizard version 3.0 introduced the concept of Smart Print. With "smart print" turned on, virtually any print file that resides on your PC and has a related file association can be printed.


	Print Wizard supports several types of files by their file extension, from text files with a .txt to graphics files with a .JPG extension. However some files only print properly through the applications that support them, such as a .DOC file. With "smart print" on, Print Wizard will try to determine, from the file extension, how best to print a file.


	If "smart print" is turned off, Print Wizard itself will try to always print the file it is given.


      
          

      

  







    

  
      
          
        
           What is the difference between Personal Edition and Service Edition?

        
          

        

        
          
          
            	Print Wizard Personal Edition includes the basic of the user interface, the Print Wizard engine and the Print Wizard DLL. It does not support any remote or despool Print Wizard or Windows services.


	The Service Edition is designed for those PCs that will be receiving print jobs from remote locations or despooling print jobs from a specific remote or local directory. Print Wizard Service Edition supports the Despool, FTPDespool, Listen and LPD protocols.


	The demo version of Print Wizard includes all capabilities. If you have been working with the demo version and are ready to order, and you're wondering which version you need, the test is simple: if you're running a service, you need Service Edition.


      
          

      

  







    

  
      
          
        
           What types of overlays does Print Wizard support?

        
          

        

        
          
          
            	Print Wizard supports several overlay files. The possible formats are a PWML file, a SPL file, an EMF file, a PCL file or a graphics file (TIFF, JPG, GIF, WMF or BMP).


      
          

      

  







    

  
      
          
        
           What versions of Windows will AnzioWin and Anzio Lite run on?

        
          

        

        
          
          
            AnzioWin and Anzio Lite will run on Windows XP and later. However, we no longer provide support for running any version of Anzio on Windows XP. To run on Vista or Windows 7, 8, 10, or 11, or equivalent versions of Windows Server, we support version 16.3m or later.


Both AnzioWin and Anzio Lite are 32-bit Windows programs, but run fine on either 32-bit or 64-bit versions of the above Windows platforms.



      
          

      

  







    

  
      
          
        
           What versions of Windows will Print Wizard run on?

        
          

        

        
          
          
            Print Wizard version 4 is supported on Windows Vista and later, including Server 2003 through 2012, Vista, Windows 7, 8, 8.1, 10, and Windows 11.


Print Wizard version 3 through 3.3 is supported on Windows XP and later. However, for Server 2008 through 2012, Vista, Windows 7, 8, and Windows 10 we require you to be on the latest release of 3.3.


Print Wizard is a 32-bit program. It will run fine on either 32-bit or 64-bit versions of the above platforms.



      
          

      

  







    

  
      
          
        
           When I first start Anzio, it asks for several options.  What are these?

        
          

        

        
          
          
            	The first prompt ask for terminal type. The terminal type refers to the type of terminal the host is expecting you to be. Most UNIX hosts support vt220 and this is a good choice if you are unsure. However, certain applications may also expect you to be using a particular terminal type and will issue various escape sequences in anticipation of your session handling it correctly. If things do not look correct on the screen, or the screen does not clear as it should, it is probably the terminal type.


	You then see a Communications Settings dialog box. This is asking you how you want to connect to the host computer. Choose one of the circles down the left side, and set the parameters next to it. If you are connecting over TCP/IP, then a host name is asked for. The host name is either the IP address of the host you wish to connect to, i.e. 213.213.213.232, or it is the actual name, i.e. library.linfield.edu. If you need to specify a non-standard port number, follow the name or IP address with a colon (":") and then the port number.



      
          

      

  







    

  
      
          
        
           Why can't AnzioWin or Anzio Lite connect to a new SSH server?

        
          

        

        
          
          
            FAILURE TO CONNECT ANZIO TO RECENT LINUX VERSIONS

May 26, 2023


There are two known issues with recent versions of Anzio Lite and AnzioWin failing to connect via SSH to recent versions of different distributions of Linux. Both issues involve the host side system's SSH program (sshd) requiring a later, more secure version of a security protocol than we have built in to Anzio so far. Following are our known mitigation strategies.


THE FOLLOWING PROCEDURES ASSUME THAT ANZIO LITE OR ANZIOWIN IS AT LEAST VERSION 17.3.


We recommend trying solution 1) and then, if that doesn't work, solution 2).


1) SYSTEM-WIDE CRYPTOGRAPHIC POLICIES (SWCP)


Recent versions of RedHat and other Linuxes have added a layer of "System-wide cryptographic policies" (SWCP) that can place additional restrictions on SSH and other security protocols. The latest versions (17.3) of Anzio Lite and AnzioWin do not qualify for SWCP's DEFAULT mode restrictions, but DO qualify for LEGACY mode.


We advise searching for "update-crypto-policies" on your Linux distro's support forum. For example, we found this page on RedHat:

   https://www.redhat.com/en/blog/how-customize-crypto-policies-rhel-82


If your Linux supports SWCP, the following apparently works, according to our users. In a shell session with root privileges do:

      update-crypto-policies --set LEGACY


2) RSA HOST KEY ALGORITHM


In this case the host's default behavior is to disallow use of the RSA protocol in determining the host key algorithm. The problem is that Anzio does not yet support any later protocols of this kind.


To fix this:


Tell the host end of SSH, that is, sshd, that it should support ssh-rsa as a host key algorithm, as follows:


* Get to a Linux shell with root permissions.


* Identify which file controls the behavior of the SSH daemon. This is usually /etc/ssh/sshd_config .


* Make a backup copy of that file, in case something goes wrong.


* Add the one line:


   HostkeyAlgorithms +ssh-rsa


to the config file (such as at the very end of the file), then save the file.


* To make sshd adopt those changes, you can


a) reboot the server


OR


b) do the command

   service ssh reload


OR


c) find the first-level sshd process-ID (PID) using ps, and do


   kill -1 <PID>


where "<PID>" is the process-ID for the initial instance of sshd.


The sshd should now accept a connection from Anzio 17.3. If it does not, please send a copy of the contents of Diagnose:Debug Comunication.

 


NOTE: We do not plan on making further enhancements to Anzio or its security protocols.



      
          

      

  







    

  
      
          
        
           Why do I get Unable to register" when I enter my license activation code?"

        
          

        

        
          
          
            Possible causes for this message are: 1) your PC has no internet access, 2) a firewall is blocking the program specifically (Barracuda does this), or 3) your program license is over registered.



      
          

      

  







    

  
      
          
        
           Why does my Anzio Lite keep asking to save parameters when I exit?

        
          

        

        
          
          
            	Ordinarily, Anzio will ask this question whenever any settings have been changed.


	If you have moved, resized, zoomed, or unzoomed the Anzio window, this will also constitute a change, if View:Track Window Position is checked. You can uncheck this item (and save your settings one more time), and then moving the window will not trigger this message.


	You can also change how Anzio behaves in Edit:Advanced Options:Security, under "Prompt to save parameters".



      
          

      

  







    

  
      
          
        
           Why won't Anzio print on my new printer?

        
          

        

        
          
          
            If you have just installed a new printer, and other Windows programs can print to it, but Anzio won't, you may have a compatibility problem. You may need to get a different printer, or else upgrade from Anzio Lite to AnzioWin. Details follow.


First, though, printing might not be an Anzio issue. Printing may flow from the host application (that you access through Anzio) directly to the printer. To test this, go to File:Printer Setup, checkmark "Debug printing", and click "OK". Print a sample job from the host application. If A "Debug print" dialog does NOT show up, then printing goes directly from the host application to the printer; you'll need to consult with whoever supports your host application. Otherwise, continue.


We'll assume you're connecting to a host system, running an application there, and telling it to print to "attached printer", "slave printer", "local printer", or similar (this is different from printing the screen). The host program may assume you have a certain kind of printer, most likely one that supports a control language called PCL-5. If your new printer does not support PCL-5, this will be a problem. One alternative is to return the printer and get a compatible one. Other alternatives follow.


First, if a print job seems to be stuck in the Windows spooler, even after you quit from Anzio, try to "cancel" it from the spooler. You may need to turn the printer off and back on. You may even need to reboot the PC.


In the following, Anzio's configurations for printing vary by version, but are all within the File menu, Printer Setup item, except as noted.


If you are running Anzio Lite, and your setting in Anzio Lite for Print Level is anything other than "High", set it to High and try again. If it prints now, but with extra characters at the beginning, and/or missing font changes, and/or incorrect alignment on the page, you probably need AnzioWin. You can download and test a demo version of AnzioWin from our website, without disturbing your Anzio Lite.


If you are running AnzioWin, turn on the Print Wizard feature. Then, in the Edit menu, go to "Advanced options" and click on the "Print Wizard" tab. Set "Translate PCL" to "Main and overlay". Click "OK". In this configuration, AnzioWin's Print Wizard feature will receive, translate, and respond to all the PCL-5 control codes. The resulting output can go to any printer that Windows supports.


You can order an upgrade (from Anzio Lite to AnzioWin) at a discounted price on our website.



      
          

      

  







    

  
      
          
        
           Windows Vista, Windows 7, 8, 10 - License will not stick"."

        
          

        

        
          
          
            The problem is that on many Windows Vista or later systems, the AnzioWin or Anzio Lite license enters OK, but does not stay around either for the next user, or in some situations, not even for the next run of AnzioWin or Anzio Lite for the same user. This problem occurs when Windows has UAC, User Account Control, enabled and it is because of various combinations of security settings. A quick solution to the problem is to run AnzioWin or Anzio Lite with elevated privileges when entering a serial number and license code for your product. To do this, follow these steps: a) Close all current running sessions of AnzioWin or Anzio Lite. b) Right-click with the mouse on top of the AnzioWin / Anzio Lite desktop shortcut and select "Run as Administrator". c) Re-enter your license information. Even if it does not ask for it, go to the Help menu and "Enter license" and do it once more. d) Close down AnzioWin or Anzio Lite and restart it normally. This should allow the license information to be accessed for all users with elevated privileges. Even though you may be logged in as an Administrator, this is the only way to make it stick on many Windows Vista and later release machines.



      
          

      

  








    

  
  

  
  





      





  




  

  




  
  
    
  
    
          
        
  
          
            


Ready to get started?

Download Place an Order







      
      





  




  

  




  
  
    
  
    
          
        
  
          
            
Copyright © 2024 Rasmussen Software, Inc. Legal Information & Privacy Policy

Send comments and suggestions to rsi@anzio.com


      
      





  




  

  





  


    
    


		

	  